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Notice

Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of
semiconductor products and application examples. You are fully responsible for the incorporation or any other use of the circuits,
software, and information in the design of your product or system. Renesas Electronics disclaims any and all liability for any losses and
damages incurred by you or third parties arising from the use of these circuits, software, or information.

Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other disputes involving
patents, copyrights, or other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or
technical information described in this document, including but not limited to, the product data, drawing, chart, program, algorithm,
application examples.

No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas
Electronics or others.

You shall not alter, modify, copy, or otherwise misappropriate any Renesas Electronics product, whether in whole or in part. Renesas
Electronics disclaims any and all liability for any losses or damages incurred by you or third parties arising from such alteration,
modification, copy or otherwise misappropriation of Renesas Electronics products.

Renesas Electronics products are classified according to the following two quality grades: "Standard" and "High Quality". The intended

applications for each Renesas Electronics product depends on the product’s quality grade, as indicated below.

"Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment;
home electronic appliances; machine tools; personal electronic equipment; and industrial robots etc.

"High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication
equipment; key financial terminal systems; safety control equipment; etc.

Renesas Electronics products are neither intended nor authorized for use in products or systems that may pose a direct threat to human life

or bodily injury (artificial life support devices or systems, surgical implantations etc.), or may cause serious property damages (space and

undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas

Electronics disclaims any and all liability for any damages or losses incurred by you or third parties arising from the use of any Renesas

Electronics product for which the product is not intended by Renesas Electronics.

When using the Renesas Electronics products, refer to the latest product information (data sheets, user’s manuals, application notes,
"General Notes for Handling and Using Semiconductor Devices" in the reliability handbook, etc.), and ensure that usage conditions are
within the ranges specified by Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat radiation
characteristics, installation, etc. Renesas Electronics disclaims any and all liability for any malfunctions or failure or accident arising out
of the use of Renesas Electronics products beyond such specified ranges.

Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products
have specific characteristics such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Further,
Renesas Electronics products are not subject to radiation resistance design. Please ensure to implement safety measures to guard them
against the possibility of bodily injury, injury or damage caused by fire, and social damage in the event of failure or malfunction of
Renesas Electronics products, such as safety design for hardware and software including but not limited to redundancy, fire control and
malfunction prevention, appropriate treatment for aging degradation or any other appropriate measures by your own responsibility as
warranty for your products/system. Because the evaluation of microcomputer software alone is very difficult and not practical, please
evaluate the safety of the final products or systems manufactured by you.

Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each
Renesas Electronics product. Please investigate applicable laws and regulations that regulate the inclusion or use of controlled
substances, including without limitation, the EU RoHS Directive carefully and sufficiently and use Renesas Electronics products in
compliance with all these applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses
occurring as a result of your noncompliance with applicable laws and regulations.

Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use,
or sale is prohibited under any applicable domestic or foreign laws or regulations. You shall not use Renesas Electronics products or
technologies for (1) any purpose relating to the development, design, manufacture, use, stockpiling, etc., of weapons of mass destruction,
such as nuclear weapons, chemical weapons, or biological weapons, or missiles (including unmanned aerial vehicles (UAVs)) for
delivering such weapons, (2) any purpose relating to the development, design, manufacture, or use of conventional weapons, or (3) any
other purpose of disturbing international peace and security, and you shall not sell, export, lease, transfer, or release Renesas Electronics
products or technologies to any third party whether directly or indirectly with knowledge or reason to know that the third party or any
other party will engage in the activities described above. When exporting, selling, transferring, etc., Renesas Electronics products or
technologies, you shall comply with any applicable export control laws and regulations promulgated and administered by the governments
of the countries asserting jurisdiction over the parties or transactions.

Please acknowledge and agree that you shall bear all the losses and damages which are incurred from the misuse or violation of the terms
and conditions described in this document, including this notice, and hold Renesas Electronics harmless, if such misuse or violation results
from your resale or making Renesas Electronics products available any third party.

This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas
Electronics.

Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or
Renesas Electronics products.

(Note 1) "Renesas Electronics" as used in this document means Renesas Electronics Corporation and also includes its majority-owned

subsidiaries.

(Note 2) "Renesas Electronics product(s)" means any product developed or manufactured by or for Renesas Electronics.

(Rev.3.0-1 November 2016)




General Precautions in the Handling of Microprocessing Unit and Microcontroller Unit Products

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas.
For detailed usage notes on the products covered by this document, refer to the relevant sections of the document as well
as any technical updates that have been issued for the products.

1. Handling of Unused Pins

Handle unused pins in accordance with the directions given under Handling of Unused Pins in the

manual.

%, The input pins of CMOS products are generally in the high-impedance state. In operation with an
unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of LSI, an
associated shoot-through current flows internally, and malfunctions occur due to the false
recognition of the pin state as an input signal become possible. Unused pins should be handled as
described under Handling of Unused Pins in the manual.

2. Processing at Power-on

The state of the product is undefined at the moment when power is supplied.

%, The states of internal circuits in the LSI are indeterminate and the states of register settings and
pins are undefined at the moment when power is supplied.

In a finished product where the reset signal is applied to the external reset pin, the states of pins
are not guaranteed from the moment when power is supplied until the reset process is completed.
In a similar way, the states of pins in a product that is reset by an on-chip power-on reset function
are not guaranteed from the moment when power is supplied until the power reaches the level at
which resetting has been specified.
3. Prohibition of Access to Reserved Addresses
Access to reserved addresses is prohibited.

%. The reserved addresses are provided for the possible future expansion of functions. Do not access
these addresses; the correct operation of LSI is not guaranteed if they are accessed.

4. Clock Signals
After applying a reset, only release the reset line after the operating clock signal has become stable.
When switching the clock signal during program execution, wait until the target clock signal has
stabilized.

% When the clock signal is generated with an external resonator (or from an external oscillator)
during a reset, ensure that the reset line is only released after full stabilization of the clock signal.
Moreover, when switching to a clock signal produced with an external resonator (or by an external
oscillator) while program execution is in progress, wait until the target clock signal is stable.

5. Differences between Products

Before changing from one product to another, i.e. to a product with a different part number, confirm

that the change will not lead to problems.

% The characteristics of Microprocessing unit or Microcontroller unit products in the same group but
having a different part number may differ in terms of the internal memory capacity, layout pattern,
and other factors, which can affect the ranges of electrical characteristics, such as characteristic
values, operating margins, immunity to noise, and amount of radiated noise. When changing to a
product with a different part number, implement a system-evaluation test for the given product.




Disclaimer

By using this Renesas Starter Kit (RSK), the user accepts the following terms:

The RSK is not guaranteed to be error free, and the entire risk as to the results and performance of the RSK is
assumed by the User. The RSK is provided by Renesas on an “as is” basis without warranty of any kind whether
express or implied, including but not limited to the implied warranties of satisfactory quality, fitness for a particular
purpose, title and non-infringement of intellectual property rights with regard to the RSK. Renesas expressly
disclaims all such warranties. Renesas or its affiliates shall in no event be liable for any loss of profit, loss of data,
loss of contract, loss of business, damage to reputation or goodwill, any economic loss, any reprogramming or recall
costs (whether the foregoing losses are direct or indirect) nor shall Renesas or its affiliates be liable for any other
direct or indirect special, incidental or consequential damages arising out of or in relation to the use of this RSK, even
if Renesas or its affiliates have been advised of the possibility of such damages.

Precautions

The following precautions should be observed when operating any RSK product:

This Renesas Starter Kit is only intended for use in a laboratory environment under ambient temperature and humidity
conditions. A safe separation distance should be used between this and any sensitive equipment. Its use outside the
laboratory, classroom, study area or similar such area invalidates conformity with the protection requirements of the
Electromagnetic Compatibility Directive and could lead to prosecution.

The product generates, uses, and can radiate radio frequency energy and may cause harmful interference to radio
communications. However, there is no guarantee that interference will not occur in a particular installation. If this
equipment causes harmful interference to radio or television reception, which can be determined by turning the
equipment off or on, you are encouraged to try to correct the interference by one or more of the following measures;

e ensure attached cables do not lie across the equipment

e reorient the receiving antenna

e increase the distance between the equipment and the receiver

e connect the equipment into an outlet on a circuit different from that which the receiver is connected
e power down the equipment when not in use

e consult the dealer or an experienced radio/TV technician for help NOTE: It is recommended that wherever
possible shielded interface cables are used.

The product is potentially susceptible to certain EMC phenomena. To mitigate against them it is recommended that the
following measures be undertaken;

e The user is advised that mobile phones should not be used within 20m of the product when in use.
e The user is advised to take ESD precautions when handling the equipment.

The Renesas Starter Kit does not represent an ideal reference design for an end product and does not fulfil the
regulatory standards for an end product.




How to Use This Manual

1. Purpose and Target Readers

This manual is designed to provide the user with an understanding of how to use the e? studio IDE to develop
and debug software for the RSK platform. It is intended for users designing sample code on the RSK platform,
using the many different incorporated peripheral devices.

The manual comprises of step-by-step instructions to load and debug a project in e? studio, but does not
intend to be a complete guide to software development on the RSK platform. Further details regarding
operating the RX130 microcontroller may be found in the RX130 Group Hardware Manual and within the
provided sample code.

Particular attention should be paid to the precautionary notes when using the manual. These notes occur
within the body of the text, at the end of each section, and in the Usage Notes section.

In this manual, the display may differ slightly from screen shots. There is no problem in reading this manual.

The revision history summarizes the locations of revisions and additions. It does not list all revisions. Refer to
the text of the manual for details.

The following documents apply to the RX130 Group. Make sure to refer to the latest versions of these
documents. The newest versions of the documents listed may be obtained from the Renesas Electronics Web
site.

Document Type Description Document Title Document No.
User’'s Manual Describes the technical details of the RSK RSKRX130-512KB R20UT3921EG
hardware. User’s Manual
Tutorial Manual Provides a guide to setting up RSK environment, RSKRX130-512KB R20UT3925EG
running sample code and debugging programs. Tutorial Manual
Quick Start Guide Provides simple instructions to setup the RSK and RSKRX130-512KB R20UT3926EG

run the first sample, on a single A4 sheet. Quick Start Guide
Smart Configurator Provides a guide to code generation and importing RSKRX130-512KB R20UT3927EG
Tutorial Manual into the e? studio IDE. Smart Configurator
Tutorial Manual
Schematics Full detail circuit schematics of the RSK. RSKRX130-512KB R20UT3920EG
Schematics
Hardware Manual Provides technical details of the RX130 RX130 Group RO1UHO0560EJ

microcontroller. Hardware Manual




2. List of Abbreviations and Acronyms

Abbreviation Full Form
ADC Analog-to-Digital Converter
API Application Programming Interface
bps bits per second
CMT Compare Match Timer
COM COMmunications port referring to PC serial port
CPU Central Processing Unit
DVD Digital Versatile Disc
E1/E2 Lite Renesas On-chip Debugging Emulator
GUI Graphical User Interface
IDE Integrated Development Environment
IRQ Interrupt Request
LCD Liquid Crystal Display
LED Light Emitting Diode
LSB Least Significant Bit
LVD Low Voltage Detect
MCU Micro-controller Unit
MSB Most Significant Bit
PC Personal Computer
PLL Phase-locked Loop
Pmod™ Thi_s is a Digilent Pmod™ (_Zc_)mpatible connector. Pmod™ s registered to Digilent Inc.
Digilent-Pmod_Interface_Specification
PSU Power Supply Unit
RAM Random Access Memory
ROM Read Only Memory
RSK Renesas Starter Kit
RTC Real Time Clock
SAU Serial Array Unit
SCI Serial Communications Interface
SPI Serial Peripheral Interface
TAU Timer Array Unit
TFT Thin Film Transistor
TPU Timer Pulse Unit
UART Universal Asynchronous Receiver/Transmitter
USB Universal Serial Bus
WDT Watchdog Timer

All trademarks and registered trademarks are the property of their respective owners.


http://www.digilentinc.com/index.cfm
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RSKRX130-512KB R20UT3925EG0100
Rev. 1.00
RENESAS STARTER KIT Jun 30, 2017

1. Overview

1.1  Purpose

This RSK is an evaluation tool for Renesas microcontrollers. This manual describes how to get the RSK
tutorial started, and basic debugging operations.

1.2 Features

This RSK provides an evaluation of the following features:
« Renesas microcontroller programming

« User code debugging

« User circuitry such as switches, LEDs and a potentiometer
« Sample application

« Sample peripheral device initialization code

The RSK board contains all the circuitry required for microcontroller operation.

R20UT3925EG0100 Rev. 1.00 nNS Page 8 of 24
Jun 30, 2017 RENES



RSKRX130-512KB 2. Introduction

2. Introduction

This manual is designed to answer, in tutorial form, the most common questions asked about using a Renesas
Starter Kit (RSK). The tutorials help explain the following:

e How do | compile, link, download and run a simple program on the RSK?
e How do | build an embedded application?
e How do | use Renesas’ tools?

Files referred to in this manual are installed using the project generator as you work through the tutorials. The
tutorial examples in this manual assume that installation procedures described in the RSK Quick Start Guide
have been completed. Please refer to the Quick Start Guide for details of preparing the configuration.

Due to the project generator, it is possible that line numbers for source code illustrated in this document do not
match exactly with that in the actual source files. It is also possible that the source address of instructions
illustrated in this manual differ from those in user code compiled from the same source. These differences are
minor, and do not affect the functionality of the sample code nor the validity of this manual.

These tutorials are designed to show you how to use the RSK and are not intended as a comprehensive introduction
to e? studio, the compiler toolchains or the E2 emulator Lite. Please refer to the relevant user manuals for more in-
depth information.

2.1 Smart Configurator Plugin

The Smart Configurator plugin for the RX130 has been used to generate the sample code discussed in this
document. Smart Configurator for e? studio is a plugin tool for generating template ‘C’ source code and
project settings for the RX130. When using Smart Configurator, it supports the user with a visual way of
configuring the target device, clocks, software components, hardware resources and interrupts for the project;
Thereby bypassing the need, in most cases, to refer to sections of the Hardware Manual.

Once the user has configured the project, the ‘Smart Configurator’ function is used to generate three code
modules for each specific MCU feature selected. These code modules are name ‘Config_xxx.h’,
‘Config_xxx.c’, and ‘Config_xxx_user.c’, where ‘xxx’ is an acronym for the relevant MCU feature, for example
‘CMT’.  Within these code modules, the user is then free to add custom code to meet their specific
requirement. Custom code should be added, whenever possible, in between the following comment
delimiters:

/* Start user code for adding. Do not edit comment generated here */
/* End user code. Do not edit comment generated here */

Smart Configurator will locate these comment delimiters, and preserve any custom code inside the delimiters
on subsequent code generation operations. This is useful if, after adding custom code, the user needs to re-
visit Smart Configurator to change any MCU operating parameters.

RSK sample project, only some functions are used.
For other useful features, refer to the https://www.renesas.com/smart-configurator.

R20UT3925EG0100 Rev. 1.00 nNS Page 9 of 24
Jun 30, 2017 RENES
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RSKRX130-512KB 3. Tutorial Project Workspace

3. Tutorial Project Workspace

3.1 Introduction

e? studio is an open source integrated development tool that allows the user to write, compile, program and
debug a software product on many of the Renesas microcontrollers.

3.2 Connecting the Debugger
For this tutorial, the E2 Lite debugger will provide power to the RSK, no external power supply is required.

The Quick Start Guide provided with the Renesas Starter Kit board gives detailed instructions on how to
connect the E2 Lite to the host computer. The following assumes that the steps in the Quick Start Guide have
been followed and the E2 Lite drivers have been installed.

e Fit the PMOD LCD display to the board. Ensure all the pins of the connector are correctly inserted in the
socket.

e Connect the E2 Lite Debugger to a free USB port on your computer.

e Connect the E2 Lite Debugger to the target hardware ensuring that it is plugged into the connector
marked ‘E1’.

3.3 Starting e? studio and Importing Sample Code

To use the program, start e?studio:

Windows™ 7: Start Menu > All Programs > Renesas Electronics e2studio > e2 studio
Windows™ 8.1 & 8: From Apps View @ click ‘Renesas Electronics e2studio > e2 studio icon
Windows™ 10: Start Menu > All Apps > Renesas Electronics e2studio > e2 studio

e Start e? studio by selecting it from the
Windows™ Start Menu. The first dialog Select a directory as workspace
bOX tO appear W|” be the Workspace e2 studic uses the workspace directory to store its preferences and development artifacts,
Launcher. Workspace: [ENTIEEEE | [ B
e Click ‘Browse’ and select a suitable
|Ocat|0n to StOI'e yOUI’ WOI’kSpace, uslng [ Use this as the default and do not ask again
the ‘Make New Folder’ option as D el
necessary. Click ‘OK'.

e The e? studio Welcome splash screen will
appear. Click the ‘Workbench’ arrow
button on the far right (circled in the
screenshot opposite).

1 Aways show Welcome at strt up

R20UT3925EG0100 Rev. 1.00 RENESAS Page 10 of 24
Jun 30, 2017



RSKRX130-512KB

3. Tutorial Project Workspace

e Once the environment has initialized, right
click in the ‘Project Explorer’ window and
select ‘Import...’

B ProjectExplorer 52 | B ¥ = O

New ¥
Show In Alt+Shift+W »
Copy Crl+C

Copy Qualified Name

2 Paste Ctrl+V
Delete Delete
ix Import.
Ly Export..
Refresh F5

e The Import dialog box will be shown.
Expand the ‘General’ folder icon, and
select ‘Existing Projects into Workspace’,
then click ‘Next'.

PS8 Import

Select

Create new projects from an archive file or directory.

Select an import wizard:

type filter text

v (= General
I Archive File
(<) CMSIS Pack
e Existing Projects into Workspace
(7 File System
ij}} HEW Project
[T} Preferences
(7} Projects from Folder or Archive
1= Rename & Import Existing C/C++ Project into Workspace
e Renesas CS+ Project for CATSKOR/CATSKO
&% Renesas CS+ Project for CC-RX and CC-RL
= C/C++
(= Code Generator

(= Install
£ RunfMehin

@ < Back Finish

Cancel

e The Import dialog box will allow you to
specify a project to import. Click the
‘Browse’ button and locate the following
directory:

C:\Renesas\Workspace\RSK\RSKRX130-
512KB

e Ensure that the ‘Copy projects into
workspace’ option is ticked, and then click
‘Finish’.

Import Projects

Select a directery to search for existing Eclipse projects.

@ Select root directory: | C:\Renesas\Workspace\RSK\RSKRX130-512KB ~|

O Select archive file:

Projects:

Application (CA\Renesas\Workspace\RSK\RSKRX130-512KB\Application)
Async_Serial (C:\Renesas\Workspace\RSK\RSKRX130-512KB\Async_Serial)

w_Power_Mode (C:\RenesastWorkspace\RSK\RSKRX130-512KB\Low_Power_Mode)

€ (CA\Renesas\Workspace\RSKARSKRX130-512KBARTC)

System_Input_Capture (C:\Renesas\Workspace\RSK\RSKRX130-512KB\System_Input_Capture)
Timer_PWM (C:\Renesas\Workspace\RSK\RSKRX130-512KB\Timer_PWM)

Touch (C:ARenesas\Workspace\RSK\RSKRX130-512KB\ Touch)

Tutorial (C:\Renesas\Workspace\RSK\RSKRX130-512KB\ Tutorial)

Options
[ Search for nested projects

[ALopy projects into workspace:

[IHide projects that already exist in the workspace
Working sets

[1Add project to working sets

@ < Back Next >

5 Import m]

=

-
Browse...

Browse...

Select All
Deselect Al

Refresh

New...

Select...

Cancel

e Click on Tutorial from the list of projects in

the ‘Project Explorer’ on the left-hand side.

- == Timer PWM
» == Touch
s 125 Tutorial

R20UT3925EG0100 Rev. 1.00
Jun 30, 2017
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RSKRX130-512KB 3. Tutorial Project Workspace

3.4 Build Configurations and Debug Sessions

34.1 Build Configuration

The e? studio workspace will be created with two build configurations: ‘HardwareDebug’ and ‘Release’.

Release

This Build Mode has optimisation turned on, and provides little debug information. The C code execution may
appear to be out of order, due to the way the compiler optimises the code. This build configuration is intended
for final ROM-programmable code.

HardwareDebug
This Build Mode has all optimisation turned off, and provides full debug information. This is the best
configuration to use whilst developing code as C code execution will be linear.

e Click the top level ‘Tutorial’ folder again, and , _— L .
then the arrow next to the build button s i WO v %, OF 0D I @
(hammer icon), and select the @ >

A 1 HardwareDebug (Debug on hardware)
‘HardwareDebug’ option.

2 Release (Release - Mo Debug)

e e2 studio will now build the code.

R20UT3925EG0100 Rev. 1.00 RENESAS Page 12 of 24
Jun 30, 2017




RSKRX130-512KB 3. Tutorial Project Workspace

3.4.2 Debug Configuration

e Click the arrow next to the debug button (bug E e Q ~ g v

icon). Select ‘Debug Configurations’. _
(no launch history)

Debug As
Debug Configurations...

Organize Favorites...

appear. Click the small arrow next to the
‘Renesas GDB Hardware Debugging’ option.

e The debug configurations for each project will
appear. Select the entry for the ‘Tutorial | &3~
HardwareDebug'.

Create, manage, and run configurations

Rernote Java Application

w [£7 Renesas GDB Hardware Debugging
[E7 Application HardwareDebug
[c7] Application Release
[E7] Async_Serial HardwareDebug
[E7] Async_Serial Release
[E7 Low_Power_Mode HardwareDebug
E Low_Power_Mode Release
[E7] RTC HardwareDebug
[E7] RTC Release
[E7 Systerm_Input_Capture HardwareDebug
[E7 Syster_Input_Capture Release
[£7] Timer_PWM HardwareDebug
[E7] Timer_PWM Release
[E7 Touch HardwareDebug
[E7 Touch Release
[£7 Tutorial HardwareDebug
[£7] Tutorial Release

[E7 Renesas Linux Application

e The ‘Debug Configurations’ dialog box will

Configure lar

- Presst

" =| - Press t
- Presst

o - Presst

- Edit or

Configure lar

v CPU Operating Mode
Register Setting

e The debug configurations control page will Name: [ Tutoril HarcwareDebug
then show for the Tutorial project. Change [2 Main[%s Debugger™. b Startup| I] Cormmon| £ Source
the main tab to ‘Debugger’ and then select Debug harchuare: | E20ite (R | Torget Device: | RSFS1208
‘Connection Settings’ on the secondary tab (698 Setings Connection Setings  Debag Too Sttings
bar that appears. v Qock -
Main Clock Source EXTAL v
i 5| Frequency[MHz] 20000
° The.re is no need to Change _the debqgger ?;tmlw.i (?u[ksD[uh:I[:c]hangeonwﬂting|ntema| Yes v
settings as they are preconfigured with the ¥ Connecton with Targt Board .
Tutorial project. Connection Type
ITag Clock Frequency[MHz] 6.00
e Refer to the RSKRX130-512KB User’s Fine e Rl M % v
. ot Plug No
Manual for details of power supply « Power
Configuration. zjsszr'{j;‘gt:tgimm'(heEmulatur[MAXEDDmA,l ‘fe:s v

Meode pin
Note: e? studio will display a warning if Crngesiar brk - .
you attempt to connect with an incorrect
power supply setting. .
e Click the ‘Debug’ button to continue. e2 —
studio will now connect to the debugger and
download the code to the target.
R20UT3925EG0100 Rev. 1.00 RENESAS Page 13 of 24
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RSKRX130-512KB 3. Tutorial Project Workspace

e Afirewall warning may be displayed for ‘e2- [ winsons securiy e ca
server-gdb.exe’. Check the ‘Private
networks, such as my home or work network’

@ Windows Firewall has blocked some features of this program

bOX and CIiCk ‘AIIOW aCCESS’. :gzig'rt\;‘l:\rewa” has blocked some features of E2 Server GDB on all public and private
Name: E2 Server GDB
e Auser account control dialog may be ] Publsher:  Renesas Eectroics Europe Lid
. .. ath: :\renesas studio \debugcom -server-gdb.exe
displayed. Enter the administrator password TR i
K . , Allow E2 Server GDB to communicate on these networks:
and click ‘Yes'. [7]Puvete netroris,such s my e o werknetnr

[FIBUBIC nétiworks, sudh as Those i airpor s and coffes shaps (ot recommended
because these netwerks aften have it o ne security)

What are the risks of allowing a program through a firewall?

e After downloading the code a dialog box will B Confirm Perspective Switch
appear asking if you would like to switch to P
the ‘Debug perspective’. Click ‘Remember - _ o o o
.. , . . This Debug perspective is designed to support application debugging. It incorporates
my deCISIOI’] to prevent th|S dla|Og bOX fl’0m wviews for displaying the debug stack, variables and breakpoint management.
appearing in future, then click ‘Yes'.

e e?studio will load the new perspective, which

R This kind of launch is configured to open the Debug perspective when it suspends.

Do you want to open this perspective now?

is optimised for debugging. [ Bemember my decision
Yes MNo
e To change back to the default ‘C/C++ P Open Perspective
perspective, from the menu bar select
Window > Perspective >Open Perspective > o
Other. c;\l Code Generator
e The ‘Open Perspective’ dialog box will ’%Debug
appear. Click on the desired perspective to §JJEW’ _
select it then ‘OK’. &{ Java Browsing
‘EgJJava Type Hierarchy
[T Resource
= Scripting
= Smart Cenfigurator
& Synergy Configuration
E]DTeam Synchrenizing
%Tracing

Gancel

3.5 Running the Tutorial

e Refer to the description.txt file in doc folder of Tutorial project for instructions on how to configure the RSK
and run the sample code.

e Once the code has been downloaded, click ‘Resume’ button ™ to run the code to the main function. The

main function is set as the program entry point by default. The program counter will stop on the first

instruction in the main function.

e Click the ‘Resume’ button %' in the ‘Debug’ perspective to run the rest of the code.

e Itis recommended that you run the entire tutorial demo first, before continuing to debug it.
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4. Reviewing the Tutorial Program

This section will look at each section of the tutorial code and basic debugging functionality in e? studio.

4.1 Program Initialization

Before the main program can run, the microcontroller must be configured. The following parts of the tutorial
program are used exclusively for initializing the RSK device so that the main function can execute correctly.
The initialization code is run every time the device is reset via the reset switch or from a power cycle.

e Build and download the code as shown in
Section 3.4.

e On the Project Explorer tab expand the
‘Tutorial’ folder by clicking on the arrow
next to the folder icon, as highlighted by
the red circle.

o= Outline | [ Project Explorer 33

» 125 Systern_Input_Capture
. 125 Timer_PWM
, 25 Touch
£ Tutorial [HardwareDebug]

e Click the arrow next to the ‘src’ folder to
show the source files.

e Expand the ‘smc_gen’, ‘r_bsp’, ‘board’, in
the order of ‘generic_rx130’ folder in the
same way and double click on ‘hwsetup.c
to open the file.

w =5 Tutorial [H ardwareDebug]
[l Includes
w [ src
w [=. SMC_gen
= Cenfig_CMTO
= Config_CMT1
= Config_ICU
= Config_PORT
= Cenfig_S12AD0
= Cenfig_5CI1
= Config_SClG&
= Ceonfig_TMRO
= general
v = r_bsp
v = board
» [= generic_r130
[£] dbsct.c
[£] hwsetup.c

e Breakpoints can be set by double clicking
at the left-hand edge of the source
window. On the line with instruction
‘R_Systeminit();’, double click next to the
vertical line to set a breakpoint.

Note: As an alternative, breakpoints may be
set in the C/C++ perspective by selecting a
line and using Run > Toggle Breakpoint.

static void peripheral_modules_enable(void)

{
/* Add code here to enable peripherals used by the application */
/* Call the Smart Configurator initialization function */
R_Systeminit();

}

R20UT3925EG0100 Rev. 1.00
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e Click the ‘Resume’ button in the Debug
perspective (or press [F8]) to run the code
up to this breakpoint.

ll

Note: The program counter is indicated by the
blue arrow next to the breakpoint.

fffaifis

~ static void peripheral_modules_enable(void)
{
/* Add code here to enable peripherals used by the application */
/* Call the Smart Configurator initialization function */
| R_Systeminit();

Click the ‘Step Into’ button (or press [F5]),
to step into the ‘R_Systeminit’ function.

=L,

e The ‘R_Systeminit’ function calls several
initialization functions which configure the
MCU for normal operation. This includes
input/output ports, and system clocks.

e The user can step through all the
initialization code by clicking the ‘Step
Into’ icon and reading the code however
for the purpose of this manual, it will be
skipped.

e Click the ‘Resume’ button, to run the code
up to the main function.

[

fff8leac

fffalebd

fff8lecd
97 fffsledl
fffaleds

fff8leds

ffaledd

fffaleee
fffalefs

- void R_Systeminit(void)

/* Enable writing to registers related to operating modes,
SYSTEM.PRCR.WORD = @xA58FU;

LPC, CGC and softwa

/* Enable writing to MPC pin function control registers */
MPC.PWPR.BIT.BGWI = 8U;
MPC.PWPR.BIT.PFSWE = 1U;

/ Initialize clocks settings */
R_CGC_Create();

/= Set peripheral settings */
R_Config PORT Create();
R_Config_512AD8_Create();
R_Config_CMT@_Create();

)
_ )
R_Config ICU Create();

R_Config _TMR®_Create();
R_Config_SCI1 Create();

/= Set interrupt settings */
R_Interrupt Create();

/* Register undefined interrupt */

R_BSP_Interruptirite(8SP_INT _SRC_LINDEFINED INTERRUPT,(bsp_int cb t)r_undefined
/* Disable
MPC.PWPR.BIT.PFSWE = @U;
MPC.PUPR.BIT.BBWI = 1U;

writing to MPC pin function control registers */

/* Enable protection */
SYSTEM.PRCR.WORD = @xA5@8U;

For further details regarding hardware configuration, please refer to the RSKRX130-512KB User’'s Manual and

the RX130 Group Hardware Manual.
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4.2 Main Functions

This section will look at the program code called from with the main function, and how it works. It is necessary
to connect the RSK G1CUSBO to a PC USB port and open a terminal emulation program, such as
HyperTerminal, with the settings 19200, 8, N, 1 and N. For information on installation of the RSK virtual COM
port driver, refer to the file ‘description.txt’ in doc folder of the e? studio Tutorial project.

*  Right click the 2 crromsecloi oo 0
‘R_Config_SCI1_Serial_Receive’ function ’ O e e et e )
call and select ‘Run to Line’ to execute the L Ffeoafe R_SWITCH Init();
program Up tO th|S I|ne The ‘R_LCD_II’”t’ ; [/* Set the call back function when SW1 or SW2 is pressed */
fUnCtion Ca” enables and Conﬁgures the j fffaaafa R_SWITCH_SetPressCallback({cb_switch_press);

LCD panel, and ‘R_LCD_Display’ will write * crrsonre et
“RSKRX130-512KB Tutorial Press Any - o _
Switch” onto the LCD. > tetsonnz R_LCD. Dislay(e, (uinte t - RSKRCLIO-SAZE )5
1 fffaeaee R_LCD_Display(l, (uintd_t *)" Tutorial ");
2 fffaeala R_LCD_Display(2, (uintd_t *)" Press Any Switch ");
/* Start the A/D converter */
5 fffseazs R_Config_ 5128D8_Start();
/* Set up 5CI1 receive buffer and callback function */
& fffaeazc R_Config_SCI1_Serial Receive(({uintd_t *)&g_rx_char, 1);
2 /* Enable SCI1 operations */
- fffaeass R_Config_SCIL Start();

e Set a breakpoint on the /* Set up SCT1 receive buffer and callback function */
'R_Conflg_SCI:L_Start’ functlon Ca” by 5 fffseglc R_Config SCI1 Serial Receive((uint8_t *)&g rx char, 1);
double-clicking in the breakpoint column. cerasone ;Hcéﬂiizsﬁﬁlsﬂiﬁ?“s

e Click the ‘Step Into’ button to step into the B B ’
‘R_Config_SCI1_Serial_Receive’ function.

2

° The program counter ShOUId now move fffslaee MD_STATUS R_Config 5CI1 Serial Receive(uint8_t * const rx_buf, uintls t rx_num)
into the ‘R_Config_SCI1_Serial_Receive’ rratacchy |
function definition. This function is an API frrames i e
function provided by the Smart PR y T T ARG
Configurator. It sets up the SCI interrupt -
handler code to receive a specified e L engeh = e num;
number of bytes into a receive buffer. rrrsies ferL e
Once the specified number of bytes has } S ’
been received, the interrupt handler code frimec vt (stotus);
calls a callback function as shown later on
in this section.

e For full details on how to configure a
project using Smart Configurator refer to
the Smart Configurator Tutorial Manual.

e Click the ‘Resume’ button to resume
program execution.

Uk
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e The program counter should come to a halt
at the ‘R_Config_SCI1_Start’ function.

e Step over the function by clicking the ‘Step
Over’ button. Alternatively, press [F6].

The ‘R_Config_SCI1_Start’ function enables
the UART interrupts. The program then
proceeds to the main while(1U) loop.

The code inside the loop waits for user input
from either the SCI or RSK switches, and then
performs an A/D conversion.

/* Set up SCI1 receive buffer and callback function */
3 fffeeoc R_Config_SCI1 Serial Receive((uint8_t *)&g rx char, 1);
/* Enable SCI1 operations */

1 fFf88936 R_Config_SCI1_Start();

e Locate the function call to ‘Icd_display_adc
inside the while loop.

e Set a breakpoint on the ‘lcd_display_adc’

function call by double-clicking in the break
point column.

= while (1U)
uintlé_t adc_result;

/* Wait for user regquested A/D conversion fl

5 fffeegdn | if (TRUE == g_adc_trigger)

/* Call the function to perform an A/D c
1 fffaeazd adc_result = get_adc();

/* Display the result on the LCD */
1 fffees4q2 lcd_display adc(adc_result);

e Inthe Project Explorer pane, locate the file
‘Config_SCI1_user.c’ and double-click to
open the source file. Scroll down to the
function
‘r_Config_SCI1_callback_receiveend'.

v =5 Tutorial [HardwareDebug]
ﬁ:;? Binaries
[k Includes
v [ src
» [ SMC_gen
= Config_CMTO
= Config_CMTI
= Cenfig_ICU
= Cenfig_PORT
= Config_S12AD0
w = Config_5CI1
[¢] Config_SCI_user.c
[£ Config_5CH.c
[R] Config_SCI.h

e Set a breakpoint on the line of code inside
the ‘r_Config_SCI1_callback_receiveend’
function as shown opposite.

e Continue to execute the program by
clicking the ‘Resume’ button.

U

198 fffglba4d - static woid r_Config_SCI1_callback_receiveend(void)

/* Start user code for r_Config SCI1_callback receiveend. Do no
/* Check the contents of g_rx_char */

fff8lbas = if (('c' == g_rx_char) || ('C" == g_rx_char))
{

g_adc_trigger = TRUE;
}

/* Set up SCIL1 receive buffer and callback function again */

fffalbde R_Config 5CI1 Serial Receive((uint8_t *)&g rx char, 1);

/* End user code. Do not edit comment generated here */

R20UT3925EG0100 Rev. 1.00
Jun 30, 2017

RENESAS

Page 18 of 24



RSKRX130-512KB 4. Reviewing the Tutorial Program

/* Check the contents of g_rx_char */

¢ In the terminal emulation window, press the trrsmbocllE  1f (0 — g rx char) || TC — g rx_char})

‘c’ button on the keyboard.

e The program will halt at the breakpoint in
the ‘r_Config_SCI1_callback_receiveend’
function as shown opposite. Remove the
breakpoint by double-clicking on the
breakpoint column.

5 fff8lbch | g_adc_trigger = TRUE;
¥

H /* Display the result on the LCD */
hd C.Ontllnue to execute the program by 4 fffgeaq2 lcd_displgy_adc(adc_resul‘t);.
clicking the ‘Resume’ button. 5

* Increment the adc_count and display

. 7 fffaeo47 - if (16 == (++adc_count))
U : {
a fffseasa adc_count = @;
® The program will halt at the breakpomt n fffaeoes2 led_display count(adc_count);

the main while loop.

e Remove the breakpoint by double-clicking
on the breakpoint column. Continue to
execute the program by clicking the
‘Resume’ button.

U

The program proceeds to display the result of the A/D conversion on the LCD and in the terminal window. In
addition, the running count of A/D conversions performed is displayed in binary form using LEDs 0-3 on the
RSK. Adjust the potentiometer and press SW1, SW2 or SW3 on the RSK and an additional A/D conversion
will be performed.

e Press the ‘Suspend’ button to halt program

execution. uu
« To change back to the default ‘C/C++’ |
. Window Help
perspective, from the menu bar select ; , ,
. - . Henilincon R -BRis| DB NI ]
Window > Perspective >Open Perspective > Editor 5
‘C/C++’. fgrzeres s ‘ i | @ Y = O |- Variables !
Show View > Name
Perspective » Open Perspective > g o/C++
Mavigation > Customize Perspective... %} Lo
&1 Refresh Debug Views el e 80 Javarowsing
Preferences : Reset Perspective... Other..
Setup Views For Device >

Close Perspective

Close All Perspectives

e Alternatively, click on the ‘C/C++’ button in ! . P
the top right corner of the screen, as shown : = | = | 1
opposite.

e This is the extent of the tutorial code.

For further details regarding hardware configuration, please refer to the RX Series Software Manual and the RX130 Group
Hardware Manual.

The E2 emulator Lite features advanced logic-based event point trigger system, and full instruction on its use is outside
the scope of this tutorial. For further details, please refer to the E2 Emulator Lite User’'s Manual.
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5. Additional Information

Technical Support

For details on how to use e? studio, refer to
the help file by opening e? studio, then
selecting Help > Help Contents from the
menu bar.

Window | Help

B
& v @ idel  Welcome

{7} Help Contents
B Search
Dyharmic Help

Parts of the sample code provided with the RSKRX130-512KB can be reproduced using the Smart

Configurator tool. Smart Configurator is included as a plugin with e? studio.

Source files and functions generated by Smart Configurator are prefixed with ‘Config_’ respectively.

For information about the RX130 Group microcontrollers refer to the RX130 Group Hardware Manual.

For information about the RX assembly language, refer to the RX Family Software Manual.

Technical Contact Details

Please refer to the contact details listed in section 9 of the “Quick Start Guide”

General information on Renesas Microcontrollers can be found on the Renesas website at:

https://www.renesas.com/

Trademarks

All brand or product names used in this manual are trademarks or registered trademarks of their respective

companies or organisations.

Copyright

This document may be, wholly or partially, subject to change without notice. All rights reserved. Duplication of
this document, either in whole or part is prohibited without the written permission of Renesas Electronics

Europe Limited.

© 2017 Renesas Electronics Europe Limited. All rights reserved.
© 2017 Renesas Electronics Corporation. All rights reserved.
© 2017 Renesas System Design Co., Ltd. All rights reserved.
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